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1. Introduction: What is this?
Pattern Bliss is a unique 
graphic design tool that 
generates limitless seamlessly 
tiling abstract patterns.  You 
can quickly create 
background patterns for 
brochures, designs for 
coloring books, custom 
wrapping paper, and even 
wrap ornate frames around 
your own photos.


This user guide will get you 
started making beautiful 
artwork right away, and then 
delve deeper into all the extra 
power features.


These generated patterns are 
all royalty-free for you to use 
in any of your own projects or 
publications, no attribution is 
necessary.
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2.Tutorial: Let's make some patterns!
Run the application.  When it opens, it presents a window with three panels.  The 
"Preview" panel in the upper right shows the current pattern. The "Settings" panel 
along the upper left side has controls that let you fine-tune the look of the currently 
displayed pattern.   The "Action" buttons along the bottom let you create completely new 
random patterns, bookmark (save) them for recalling later, add another image behind the pattern, 
send patterns to friends, or or read this user guide.


You can instantly make new patterns by simply pressing the “Randomize” Action button.  Each 
press will "intelligently scramble" the settings and create a unique pattern.


Or you can get more creative and fine-tune and customize your creation, by adjusting any of the 
settings yourself.  When you tap on one of the settings buttons, it will open a popup slider, letting 
you adjust the value of that particular setting.  As 
you adjust the value, the displayed Preview 
pattern will immediately update, showing you the 
effect you are creating.  Letting go of the slider 
will automatically close the popup, so you 
choose another setting to adjust.


You can also tap the arrow-buttons on either 
side of the slider, or type the left-arrow and right-
arrow on the keyboard, to nudge the slider value up and down step-by-step.





For now, try “Zooming out” to 3 or 4, then choosing some different Function settings 
and see what happens.





After choosing a function, now adjust the “Ripple Freq” setting, and then try the “Swirl” 
setting, and see how they alter the pattern.


You can also tap the Light Color and Dark Color settings to change the two “endpoint” colors 
used for painting the pattern.





Once you have something you like, you can bookmark this pattern to re-display later on by 
tapping the "Bookmark" Action button and saving the bookmark.





You can save the pattern image to your photo library or send it to somebody by tapping the 
Share Action button.


You can also save it as a high quality PNG or JPG image file by choosing “Save 
Image…” from the File menu.  See the “App Preferences” section below to 
learn how to change the file type and image size.
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3.What can I make with it?
These flowing abstract patterns can be simple or 
complex, colored or B&W lines, single panel or 
seamlessly repeating. There are so many things 
you can create with them… here are a few ideas:


• Create small images that create large seamless 
backgrounds for web pages.


• Make unique patterns to brainstorm new 
artwork ideas.


• Make backdrops and add your own artwork 
over them.


• Use the patterns as templates for gilding, 
electro-plating, silk-screening, or 3D printing


• Generate ornate "Picture Frames" to lay over 
your own image/photo.


• Make seamless tile artwork assets for wall or 
floor textures in your computer games.


• Create abstract artwork for your own coloring 
books.


• Create a variety of striking slide backdrops for 
presentations.
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4.How do I…
Here are some quick tips on how to do some cool things with this software.


Create a frame for your photo or artwork
You can create a pattern and cut out the middle area to let your photo or artwork show through, then 
lay the pattern over your photo using a word processor or image layering or page layout software.


1. First, create a pattern with the colors you like.


2. Now you need to "cut away" the pattern in the middle of the photo, and show only a border 
around the edges.  Tap the "Border Inset" setting, and drag the slider out until it looks 
about the right size.


3. You can change the shape of the inner cutout area to square or rounded-square or circle.  
Those can be chosen by tapping the "Border Style" setting, and choosing the shape you 
want.


4. You can also change how sharply the border fades the pattern out to the photo in the 
middle.  Change this fade-out amount by tapping the Border Fade setting, and adjusting 
the slider to taste.


5. Now make sure you have one of the Transparency modes on, so you can see through the 
pattern.


6. Finally, save the pattern, or share it out to another computer to edit.


Once you have the pattern file, you can import it, along with your photo, into a word processor or 
page layout application, and bring the pattern to the front and stretch/lay it over the photo.


Know which images will tile seamlessly
Many of the functions seamlessly tile, and 
many do not.  There are some settings that 
will distort a seamless pattern until it is no 
longer perfectly seamless.  There are also 
some tricks to make non-seamless tiles 
become seamless.  So here is a quick 
overview of what to look for to stay safely 
seamless, and how to venture off the edge 
into the discontinuity of dragons, and how 
to get back again.


A quick way to visually see if a pattern will 
seamlessly tile is to choose the “Tile-Up” 
Setting and choose "2-up".  You can then 
sight along the two perpendicular gray lines that cross the middle of the Preview area, and see if the 
pattern matches up to itself on either side of those gray lines.


The functions that are not seamless are: waifstn, riktascale, fleurd, syren, dadabada, dadaisnt, 
dadisgrate, momamom, sinehere, dysterbia, guppypool, betemoire, moireless, costic, klydescope, 
fourfarms, diatron,  nospork, teebone, sqrzfred, sqrzrcl, sumoire, duedate, twinpokes, ihorus, 
frdnand, blistk, ladya, diadotz, hyprbowl, runion, wootnany, nualiens.
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Most of the settings will not change a seamless tile 
into non-seamlessness.  The one setting that 
usually does destroy the seamlessness is “Lens 
Bulge.”  However, even with this setting, if you 
change it to exactly 0.25 or 0.50, certain functions 
will snap the distortion back into seamlessness.


Another option is to turn on the Symmetry setting, 
and use 2-axis perpendicular or 4-axis symmetry, 
which can often make a discontiguous pattern 
seamless again.


Bump those sliders up and down just one tick
Some of the sliders have a lot of values (e.g., the “Functions” slider) and it is hard to get to the exact 
spot by simply sliding the knob back and forth.  At either end of the slider is a button.  The left side 
will make you grow smaller, and the right side will make you grow larger.  For some settings with 
discrete values, these buttons will bump to the next or prior value.  For smooth/continuous settings 
(e.g., Amplitude or Color) they will simply “bump” a small distance either way.  On the far left is a 
“reset” button, which will set the value immediately back to zero.


On the Mac: When a setting slider popover is displayed, you can also press the right or left arrow 
keys, or the “U” or “D” keys on the keyboard to move the value up or down one position.  You can 
also type the number zero key (0) to reset the slider to its default setting (usually far left.)


Print this user guide to a printer
Here is how you would print out a copy of this user guide, instead of viewing it on-screen.


First open the user guide window by choosing “Pattern Bliss User Guide” from the “Help” menu.  
With that window displaying, now choose “Print” from the “File” menu, and it will print the entire user 
guide to your printer.


-or-


Open your web browser on your desktop computer, and go to the Pattern Bliss product web site: 
www.schwansongs.com/patternbliss/


Then scroll down to the Pricing section, and you will see that there is a free “User Guides” download 
button.  Click it to get the full PDF file to your computer, which you can now open and print.


Quickly “move” a cool pattern between your iPhone & your 
computer

Apple Handoff is supported!  If you have Pattern Bliss 
installed on a couple of your devices, iPhone or Mac, 
connected to the same iCloud account, you can use 
“Handoff” to instantly show the same pattern on both devices.  
For example, whenever you run Pattern Bliss on your iPhone, 
a little Pattern-Bliss 'handoff icon' appears on your nearby 
Mac.


If you click that icon on your Mac, Pattern Bliss launches and 
shows the identical pattern from your iPhone.  You can read more about Apple's Hand-Off 
technology here: https://support.apple.com/en-us/HT209455
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Change the color of the Settings/Action buttons
The buttons use the color you have chosen as your computer’s “Accent Color”, which you can 
change in the System settings, under the General pane:  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5.What does this thing do?
Let's dive into the details, and describe the screen and each of its controls.


Main Screen
The main screen contains three main panels, which let you adjust the patterns, get a preview of what 
the pattern looks like, and do other useful things like bookmark a favorite pattern, share it with 
friends via e-mail or messages, or read this useful guide.





Preview Panel
The Preview panel shows the pattern you are working on, and will 
grow or shrink as you resize the window.  Note that making the 
window larger on the Macintosh will slow down the graphic 
responsiveness a bit.


The pattern reacts and updates immediately as you change values 
of settings.


If you would like to see a text summary of all the settings that make 
this pattern, simply click the pattern preview image, and a popup 
window will show a list of every setting value.  To close the popup 
window, press the <ESC> key or click somewhere off the Pattern 
Bliss window. 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Settings Panel
The settings panel contains all the controls that let you adjust the appearance 
of the pattern.  You can choose the basic mathematical functions that 
generate it, change various zoom and distortion effects, coloring effects, and 
transparency.  You can even cut out an inner area to create a picture frame 
"border" effect.


Before I dive into the details, I will give your mind a better visual idea of what it 
is you are looking at, and this should help you get a feel for what each of the 
settings do, without getting too heavily into any pesky mathematics or 
trigonometry.  These patterns are actually 3-dimensional shapes, cut into a 2-
dimensional slice on the screen, so think back to your 2-dimensional and 3-
dimensional math graphing days for a moment.


Pretend like the preview pane is a flat (2-dimensional) square of paper held 
out in front of you.  I will describe the pattern drawn on this paper using X, Y, 
Z direction names, so remember these direction names, or axes, for the 
settings below.  Directions to the left and right (across the page) will be along the "X"-axis.  
Directions up and down (toward the top and bottom of the page) will be along the "Y"-axis. 
Directions "into" and "out of" the page (toward and away from you) will be along the "Z"-axis.  Now 
imagine some wiggly cloud shape in the air, which is being " sliced by the paper you are holding, so 
that you can now see the sliced wiggles on the page where it cuts through.  Keep that idea in mind 
when reading these descriptions of the settings.


Function: List of abstract patterns (3-D curve functions) that can be dropped in and sliced with 
your paper.  Each function has a smirky mnemonic name and a numeric identifier.  Note that 
because the Lite version of the software has fewer functions, it will have gaps in its list of 
function identifiers.


Zoom: Zooms out with higher slider numbers, making the pattern shrink, so more will fit on the 
page.


Amplitude: Stretches the pattern just along the Z axis (toward and away from you) on the page, 
making the curve lines steeper/thinner/sharper.


SliceHeight: Moves the paper toward you along the Z axis on the page, "cutting" a different 
section of the 3-D curves along that amplitude.


Waffle: Increases the frequency (tightness) of "waffling" that overlays the function value, sort of 
like adding corrigated egg-cartons to the function.


Ripple Freq: Increases the frequency (tightness) of ripples that wash across the X and Y axes, 
"crinkling up" the function you chose.


Lens Bulge: Similar to Ripple Freq above, but this distorts the function with multiple individual 
circle ripples instead.  Increasing the slider value will increase the frequency of the waves (make 
them closer together.)


Swirl: Distorts the overall image into a spiral shape, with the most swirl at the center, either 
twisting Clockwise or Counter-Clockwise from the center slider position.


Coloring Style:


• "Color Gradient" - Starts at the Light color, and ramps to the Dark color.
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• "Darken" - Starts at the Light color, and ramps to a darker version of the same Light color.  The chosen 
Dark color is not used in this mode.


• "Stripes" - Threshold: draw light color for any value less than “SliceHeight”, and draw dark color for 
greater than “SliceHeight”.


• “Band-It” - Banded-Gradient: break the color gradient into 8 darkening bands, and alternate between 
the Light color and Dark color for each band.


• "Thin Lines" - similar to 2-band, but the threshold is down near 20% to thin the line.

• "Thick Lines" - similar to 2-band, but the threshold is at 50% and light/dark colors are flipped.

• “2-Color" - Similar to “Stripes”, but uses your chosen 

“Light Color” as the first color, and then calculates 
the second “Dark color” as 50% beyond the “Light 
Color” along the color slider.  If the second color 
would then be beyond the end, it will wrap around 
from the beginning.


• “4-Color" - Similar to “Stripes”, but uses your 
chosen “Light Color” as the first color, and then 
calculates the next 3 colors 20%, 40%, 60%, and 
80% beyond the “Light Color” (wrapping around 
just like 2-color above.)


Light Color: This is a color hue slider, letting you choose a bright color rotating through all the 
colors from red, green, blue, purple and back to red.  Color saturation is fixed at 75%, 
brightness set at 100% (bright.)


Dark Color: This is a color hue slider, letting you choose a dark color going through all the 
colors from red, green, blue, purple and back to red.  Color saturation is fixed at 100%, 
brightness set at 30% (dark.)


Transparency: This allows you to add transparency to certain parts of the image, from none 
(opaque), to making either the lighter colors transparent or the darker colors transparent.


• "Opaque" - Image is completely opaque, no transparency.

• "Light-Ramp" - Lightest color is completely opaque, gradually getting more transparent as colors get 

darker.

• "Light-Cutoff" - Lighter colors are completely opaque, switching to completely transparent for darker 

colors.

• "Dark-Ramp" - Darkest color is completely opaque, gradually getting more transparent as colors get 

lighter.

• "Dark-Cutoff" - Darker colors are completely opaque, switching to completely transparent for lighter 

colors.
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Symmetry:


• "No Symmetry" - Displays the pattern as-is in the square, without adding mirror/symmetry.  This allows 
things like "Swirl" to add asymmetrical distortions across the pattern.


• “1-axis (Horizontal)”: mirrors up/down across the X (horizontal) axis.


• “1-axis (Vertical)”: mirrors left/right across the Y (vertical) axis.
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• “1-axis (Diagonal Forward)”: mirrors across one diagonal axis.


• “1-axis (Diagonal Backward)”: mirrors across one diagonal axis.


• “2-axis (Perpindicular)”: mirrors across the X and Y axes.
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• “2-axis (2xDiagonal)”: mirrors across two diagonal axes.


• “4-axis (Diag&Perpindicular)”: mirrors across four axes (X, Y, and 2 diagonals.)


Tile-Up:


•"1-up" - draws a single full-sized pattern, no repeating.

•"2-up" - draws the pattern as 4 repeated tiles in a larger square so you can see how the edges mesh.  
Also turns on a light blue cross-hair line to demarcate the seams.

•"3-up" - draws 9 patterns, three tiles across, three down.

•"4-up"- draws 16 patterns, four tiles across, four down.


Crop Inset: This slightly shrinks the tile inside the margins (and draws a little outside the edge of 
the tile), and draws crop-marks where the very edge should be.  Goes from 0 (no inset) to 1 
which is about 20% inset.


Border Inset: How large the border shape cutout should be. 0 is invisible, and it expands from 
the center toward 1, where it leaves just a small percentage of the pattern around the edge.
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Border Feathering: How much feathering, or fuzziness to add to the border edges. 0 is a sharp 
edge, 1 is very soft blurry transition.


Border Shape:


• "Rect" - square cutout

• "Round-Rect" - square cutout with rounded edges

• "Circle" - circle cutout


Tip: On the Mac, you can hover your mouse pointer over any of the Settings buttons, and a tool-tip 
will appear showing you the name of the setting button, and its current value.  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Actions Panel
The Actions panel contains buttons that let you do things like instantly scramble all the Settings to 
some new random pattern, load one of your photos in behind the pattern, save or load the current 
pattern to/from a bookmark list, share your created pattern out via e-mail or to your photos, and 
access this user guide.


Randomize (All Settings)
This button will do a "smart-randomize" of most of the Settings, wildly scrambling some, and 
carefully-scrambling others, to insure that each time you click, you will get a new interesting 

pattern.  Certain settings are always left untouched, in case you want to leave them set a certain way 
and just randomize the other settings.  The settings that are left unchanged are: Transparency, Tile-
Up, Crop Inset, Border Inset, Border Style, and Border Feathering.


Reset (All Settings)
This button will reset all of the Settings controls back to their original "zero" values.  This can be 
useful if you changed many of the settings, and don't want to manually move each one back.


Bookmarks
This brings up a "Bookmarks" popover 
window, letting you see and manage all the 
bookmarked patterns you have.  You can save 

the currently displayed pattern as a new 
bookmark, or you can select an already saved 
bookmarked pattern from the list of thumbnails 
and load it back in as the current pattern, or 
you can clear (remove) either the selected 
bookmark or all the saved bookmarks.


Each pattern is displayed with a small 
“thumbnail image” of the pattern (with 
transparency shown if it has it), and a terse text 
description of some of the main settings that 
create it.
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Share
This brings up a popup list of places you can send the current pattern to… messages, e-mail, 
photo library, AirDrop to another device, etc.


Information
This brings up a window showing this user guide.  You 
can scroll through the pages to read it, and increase the 
window size for larger text.  You can also click on any 

page number on the first page’s table of contents and it 
will jump right to that page.


You can also choose PRINT from the File menu to print a 
copy of the user guide if you like. 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Menu items
The menus along the top "menu bar" contain special commands for saving/randomizing/
bookmarking your patterns, etc.  Here are descriptions of the items specific to Pattern Bliss.


Pattern Bliss Menu

About: This will open a "Credits" window, displaying credits for everyone who helped create this.  
You can even listen to some music I wrote while you read.


Preferences: Choose this item to open a window that lets you change application-specific settings. 
These settings are described in the next section under "App Preferences".


File Menu

Close: Closes the window, and the application, just like "Quit".


Save Image: This will allow you to save the currently displayed pattern as an image file.  It can be 
either PNG or JPEG format (depending on which suffix you add to the file name, .png or .jpg.  Its 
dimensions will be based on the image width (pixels) you chose in the app preferences window.


Share: Quickly send the pattern as a graphic image to your friends, via e-mail, message, etc.


Edit Menu

Copy Image: Copies the current pattern as an image to the clipboard.


Copy Info Text: Copies all the settings that make the current pattern as a text string to the 
clipboard.


Action Menu

Randomize: Shortcut which does the same thing as the Randomize Action button, see "Actions" 
section above.


Reset all Settings: Shortcut which does the same thing as the Reset Action button, see "Actions" 
section above.  Note the keyboard equivalent is <command>-ZERO.


Save Bookmark: Shortcut which does the same thing as clicking the "Save current pattern to 
Bookmark" button, see the Bookmark dialog in the "Actions" section above.  This menu item is 
disabled if this pattern is already saved as a bookmark.


Help Menu

Pattern Bliss User Guide: This menu item opens a window that displays this user guide.  You can 
adjust the size of the text by resizing the window larger or smaller.  You can also choose "Print" from 
the File menu, to print a copy of the user guide if you like.


Pattern Bliss Introduction: This menu item opens a window that displays a multi-tabbed 
introduction, illustrating some of the features of the software.


Pattern Bliss Feature Comparison: This menu item opens a window that displays the feature 
differences between the Lite and the Full versions of this software.
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Rate/Review Pattern Bliss: This menu item opens an Apple App-Store window that lets you add 
your rating, and write a review for this software, letting others know how you like it.


Pattern Bliss Product Web Page: This menu item opens a browser window that displays the 
product web page for this software.


Company Web Page: This menu item opens a browser window that displays my company web 
page. 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App Preferences
Choose "Preferences" from the "Pattern Bliss" menu to open a window that lets you change 
application-specific settings. The settings on here do not affect your patterns, but instead alter the 
look or behavior of the overall application itself.


Startup

Upon startup: This setting lets you choose what the software does each time you run the app.  You 
can have it either display the same pattern you left it with last time, or you can have it display a new 
random pattern each time.


File Stuff

Save image file as: You can choose to save your images as JPEG files, or as PNG files.  The main 
difference between these two formats is that JPEG files will not keep any transparency values, and 
will be completely opaque.  PNG format can preserve any transparency in your image.  Also, JPEG 
files are often a little smaller files, but also a little lower quality.


Saved file name starts with: If empty, the software will create a default filename string when you 
save your file.  If you enter some text here, then that text instead will be used as the beginning of 
your file name.  You can always edit the name before you save it, but if you find yourself naming a 
bunch of files almost the same thing, this can pre-fill part of the file name for you.


Save images at this width (pixels): This setting lets you choose a destination image size whenever 
you save or share an image.  It can be any size from 100 to 4000 pixels wide.  Since the images are 
square, this size is used for both height and width.


Extras

Show crop marks on images: This setting lets you display outer "crop-marks" on image files you 
save or share, to help align and cut along the edges of the patterns.  The crop marks will only show 
up when you have added a CROP INSET setting.


_____________________________________

Pattern Bliss User Guide - Page   of  20 22

_____________________________

Copyright 2022, SchwanSongs



Use gray-scale for images: This setting lets you choose whether to display the images as full-color 
(using the Light-Color and Dark-Color settings), or to display in Gray-Scale.  This setting also affects 
the saved and shared images.


Sticky Settings Sliders: Normally when you tap on a Setting button and the slider window pops up, 
you can slide the slider to some new position and let go, and the slider window will automatically 
close.  If you turn this setting on, then the slider window will now stay open after you let go.  You can 
later close it by tapping anywhere outside the slider window. 


Display main window in "Dark Mode": On older macOS versions that didn’t have “Dark Mode”, 
this setting lets you choose to change the window appearance to “dark mode”.  This checkbox only 
appears on macOS 10.12 and earlier.  For newer versions of the OS, you can simply use your 
System Preferences to turn on dark mode system-wide, and this software will obey your settings.
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6.More Information
This software was written by Eduard Schwan of SchwanSongs.


After 4+ years, it has grown to over 25,000 lines of Objective C code, carefully designed and tested 
by me and a small group of friends.


Feel free to contact me if you have a feature idea you would like to see added, or any problems you 
have found.  I always do my best to update my software so that it does what you want.


Send any feedback or correspondence to: note@schwansongs.com
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SchwanSongs
Bringing Software to Delight!
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